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The purposes of this study were designing and creating info graphic which is about 

underprivileged disabled who were abandon form social. This study would encourage people to 

pay attention to disabled people and educate about equality. Info graphic or info-Graphic could 

leaded to the creativity process of Pop-Art for originality and had the simplicity as the creator 

interested. Moreover, the audiences could understand the problem of people with disabilities 

clearly in 3 minutes. This info graphic suitable for the audiences who were 18-35 years old which 

is education age and working age. 

 

  
  
 
 
 
 
 
 
 
 
 
 
 
Student’s Signature………..………………. .Thesis Advisor’ s Signature……………………..… 



ง 

 

สารบัญ 

 

           หน้า 
กติติกรรมประกาศ   ก 
บทคดัย่อภาษาไทย   ข 
บทคดัย่อภาษาองักฤษ   ค 
สารบัญ ง 
สารบัญรูป ช 
 
บทที ่1 บทนํา 1 
 1.1 ท่ีมาและความสาํคญั            1 

1.2 วตัถุประสงค ์       2 
 1.3 ขอบเขตของการวิจยั  2 

 1.4 วิธีในการดาํเนินงาน        2 
 1.5 ประโยชนท่ี์คาดวา่จะไดรั้บ  3 
 1.6 นิยามศพัท ์ 3 

 
บทที ่2 เอกสารและงานวจิยัทีเ่กีย่วข้อง        4 
 2.1 แนวคิดท่ีเก่ียวขอ้งกบัการสร้างส่ืออินฟอร์เมชนักราฟิก 4 
  2.1.1 หลกัการออกแบบอินฟอร์เมชนักราฟิก 5 
  2.1.2 การสร้างอินฟอร์เมชัน่กราฟิกใหดึ้งดูดความสนใจ 5 
  2.1.3 การสร้างอินฟอร์เมชัน่กราฟิกใหมี้ประสิทธิภาพ 6 
 2.2 ศิลปะป๊อป อาร์ต (Pop Art) 6 
 2.3 แนวคิดเก่ียวกบัสิทธิของคนพิการ    9 
  2.3.1 ประเภทของคนพกิาร     9 
 

 
 



จ 

 

สารบัญ (ต่อ) 

 หน้า 
 2.3.2 บุคคลท่ีมีความบกพร่องทางการเห็น   10 
 2.3.3 บุคคลท่ีมีความบกพร่องทางการไดย้นิ  11 

 2.3.4 บุคคลท่ีมีความบกพร่องทางสติปัญญา     11 
 2.3.5 บุคคลท่ีมีความบกพร่องทางร่างกายหรือสุขภาพ  11 

 2.3.6 บุคคลท่ีมีปัญหาทางการเรียนรู้  12 
 2.3.7 บุคคลท่ีมีความบกพร่องทางการพดูและภาษา  12 

 2.3.8 บุคคลท่ีมีปัญหาทางพฤติกรรมหรืออารมณ์  12  
 2.3.9 บุคคลออทิสติก  13  
 2.3.10 บุคคลพิการซอ้น  13 
 2.4 การแกไ้ขปัญหาเพ่ือส่งเสริมและคุม้ครองสิทธิคนพิการ  13 
  2.4.1 ดา้นกฎหมาย  13 

 2.4.2 ดา้นเจตคติ  14  
 2.4.3 ดา้นการศึกษา  14  
 2.4.4 ดา้นอาชีพ  14  
 2.4.5 ดา้นส่ิงอาํนวยความสะดวกอนัเป็นสาธารณะ  14  
 2.4.6 ดา้นกองทุน  14 

 
บทที ่3 ระเบียบวธีิการวจิยั  15 

 3.1 แนวคิดการเขียนบทอินฟอร์เมชนักราฟิกแนวศิลปะป็อปอาร์ต  15 
 3.2 แนวคิดในการออกแบบตวัละครและฉาก  17 
 3.3 ขั้นตอนการผลิต  18 
  3.3.1 การตกแต่งภาพกราฟิก  18 
 3.4 การสร้างภาพเคล่ือนไหว  24 
  3.4.1 การจดัแสง  25 

 



ฉ 

 

สารบัญ (ต่อ) 

 หน้า 

 3.5 ขั้นตอนหลงัการผลิต  26 
 3.5.1 Render  26 

  3.5.2 Composite  26 

  3.5.3 การตดัต่อเสียงประกอบ  27 

 

บทที ่4 ผลการวจิยั  28 
 4.1 ผลการออกแบบอินฟอร์เมชนักราฟิกแนวศิลปะป็อปอาร์ตเพ่ือผูพ้กิารท่ีดอ้ย ฯ  28 
 
บทที ่5 สรุปเสนอแนะ  39 
  5.1 สรุปผลการวิจยั  39 
 5.2 ปัญหาและขอ้เสนอแนะ 39 
 5.2.1 ดา้นระยะเวลา 39 
 5.2.2 ดา้นการผลิต  39 
 5.2.3 ดา้นเน้ือเร่ือง 40 

 
บรรณานุกรม   41 
 

ประวตัิผู้จดัวจิยั   42 

 

 

 

 

 



ช 

 

สารบัญรูป 

 

 หน้า 

รูปที ่  

2.1 ส่ืออินฟอร์เมชัน่กราฟิก    4 
2.2 ส่ืออินฟอร์เมชัน่กราฟิก    5 
2.3 Richard Hamilton    7 
2.4 Andy Warhol : Green Marilyn C.1964    8 
3.1 ตน้แบบเพ่ือสร้างส่ืออินฟอร์เมชัน่กราฟิก  17 
3.2 การออกแบบตวัละคร  17 
3.3 การออกแบบตวัละคร  18 
3.4 โปรแกรมท่ีใชท้าํงาน  18 
3.5 รูปตน้แบบ  19 
3.6 ขั้นตอนการสร้างMotion Graphic  19 
3.7 ขั้นตอนการสร้างMotion Graphic  20 
3.8 ขั้นตอนการสร้างMotion Graphic  20 
3.9 ขั้นตอนการสร้างMotion Graphic  21 
3.10 ขั้นตอนการสร้างMotion Graphic  21 
3.11 ขั้นตอนการสร้างMotion Graphic  22 
3.12 ขั้นตอนการสร้างMotion Graphic  22 
3.13 ขั้นตอนการสร้างMotion Graphic  23 
3.14 ขั้นตอนการสร้างMotion Graphic  23 
3.15 การออกแบบภาพเคล่ือนไหว  24 
3.16 การออกแบบภาพเคล่ือนไหว  25 
3.17 การออกแบบการจดัแสง  25 
3.18 ขั้นตอนการผลิต  26 
3.19 ขั้นตอนการผลิต  26 

 



ซ 

 

 
สารบัญรูป (ต่อ) 

 

 หน้า 

รูปที ่

3.20 ขั้นตอนการผลิต  27 
3.21 ขั้นตอนการผลิต  27 
4.1 ฉากเปิดหนา้จอคอมพิวเตอร์  29 
4.2 อุปกรณ์ต่าง ๆบงบอกถึงความกา้วหนา้ทางเทคโนโลย ี  30 
4.3 สงัคมเมืองท่ีมีตึกสูง  30 
4.4 การใชชี้วิตประจาํวนัของผูค้นในสงัคม  30 
4.5 ทุกคนในสงัคมไดรั้บความสะดวกสบายจนมองขา้มความมีนํ้าใจใหก้บัคนรอบขา้ง  31 
4.6 ภาพผูค้นค่อย ๆ จางหายไป  31 
4.7 สญัลกัษณ์อุปกรณ์ในการทาํงานค่อย ๆ ชดัออกมา  31 
4.8 ทุกอยา่งหยดุลง ผูพ้ิการไม่ผา่นการทาํงาน  32 
4.9 อุปกรณ์ทางการศึกษาค่อย ๆ เขา้มาประกอบในฉาก  32 
4.10 อุปสรรคของผูพิ้การดว้ยส่ิงอาํนวยความสะดวก  32 
 อุปกรณ์ทางการศึกษายงัมีไม่ทัว่ถึงกบัจาํนวนของผูพิ้การ 
4.11 ฉากหอ้งเรียนค่อย ๆ หายไป  33 
4.12 รถบสัว่ิงเขา้มาในฉาก  33 
4.13 บริการขนส่งมวลชน ยงัไม่เพียงพอต่อความตอ้งการในการใชง้าน  33 
4.14 ฉากป้ายรถเมลค่์อย ๆ ถกูรูปทรงส่ีเหล่ียมปิด  34 
4.15 ท่ีจอดรถของผูพิ้การถูกแยง่ท่ีจอดโดยคนท่ีมีร่างกายปกติ  34 
4.16 ภาพของผูพิ้การค่อย ๆ ปรากฏข้ึนมา  34 
4.17 ภาพของผูพิ้การท่ีเสียขาไป  35 
4.18 ภาพชายพิการท่ีมีอาการหงุดหงิด  35 
4.19 ภาพคนพิการแสดงอารมณ์โมโห  35 
4.20 กลอ้งซูมผูห้ญิงพิการทางสายตา  36 



ฌ 

 

สารบัญรูป (ต่อ) 
 

 หน้า 

รูปที ่

4.21 กลอ้งค่อย ๆ ซูมออกจากผูห้ญิงพิการทางสายตา  36 
4.22 กลอ้งซูมออกไดเ้ห็นถึงผูค้นในสังคม  36 
4.23 ภาพชายพิการจูงสุนขัค่อย ๆ ชดัข้ึนมา                  37 
4.24 ภาพชายพิการจูงสุนขัถูกผูค้นในสงัคมดูถูกว่าร้าย                       37 
4.25 รูปสัญญาลกัษณ์ผูพ้ิการ  37 
4.26 ผูพิ้การใชชี้วิตร่วมกบัผูค้นในสงัคม   38 
4.27 กลอ้งหมุมรอบๆ ผูค้นในสงัคม    38 
 



 
 

บทที่ 1 
 

บทนํา 
 

1.1 ทีม่าและความสําคญั 
 
 อินฟอร์เมชัน่กราฟิกหรืออนัโฟกราฟิก (Infographic ,Graphic ,Info-Graphic) หมายถึงการ
นาํขอ้มูลหรือความรู้มาสรุปเป็นสารสนเทศ ในลกัษณะของกราฟิกเป็นภาพน่ิงหรือภาพเคล่ือนไหว
ดูแลว้เขา้ใจง่ายในเวลารวดเร็วและชดัเจน สามารถส่ือให้ผูช้มเขา้ใจ ความหมายของขอ้มูลทั้งหมด
ได ้โดยไม่จาํเป็นตอ้งมีผูน้าํเสนอเขา้มาช่วยขยายความเขา้ใจ การออกแบบอินฟอร์เมชัน่กราฟิก เป็น
การเขา้ขอ้มูลท่ีเขา้ใจยาก หรือองคป์ระกอบท่ีสาํคญั คือ เร่ืองท่ีจะเล่า ภาพท่ีจะแสดง และเสียงท่ีจะ
ไดย้ิน กราฟิกท่ีใชอ้าจเป็นภาพลายเส้น สัญลกัษณ์ กราฟ แผนภูมิ ไดอะแกรม ตาราง แผนท่ี ฯลฯ 
กราฟิกท่ีแสดงความสวยงาม น่าสนใจและสรุปขอ้มูลไดดี้เขา้ใจง่าย สามารถจดจาํไดน้าน ทาํใหก้าร
ส่ือสารมีประสิทธิภาพมากข้ึน ศิลปะป็อปอาร์ต ซ่ึงเป็นงานศิลปะท่ีสร้างความต่ืนเตน้พุ่งข้ึนมา
ทันทีทันใดแก่ผู ้พบเห็น อันมีเร่ืองราวเก่ียวข้องกับคนทั่วๆ ไปเป็นเร่ืองราวป็อปอาร์ตท่ีส่ือ
ตรงไปตรงมาเสียดสีสังคม เนน้แสดงออกทางอารมณ์ความรู้สึก และมกัหยิบจบัเร่ืองท่ีคนในสังคม
พูดถึงมาสร้างเป็นผลงาน จึงเป็นท่ีน่าสนใจในการนําแนวความคิดของศิลปะป็อปอาร์ตมา
ผสมผสานกบังานอินฟอร์เมชัน่กราฟิกเพ่ือใหมี้ความเขา้ใจในรูปแบบงานและเน้ือหามากข้ึน 
 สังคมไทยมีผูพ้ิการเป็นจาํนวนมากทั้ง ผูพ้ิการทางสายตา ผูพิ้การทางหู และผูสู้ญเสีย
อวยัวะต่างๆ ผูพิ้การเหล่าน้ียงัขาดการดูแลเอาใจใส่  เราจึงพบเห็นไดม้ากในกรณีของขอทานท่ีเป็นผู ้
พิการเน่ืองจากขาดการอุปการะดูแลและเยยีวยา โดยใชเ้ทคนิคอินฟอร์เมชัน่กราฟิกแนวศิลปะป็อป
อาร์ตผ่านกระบวนการออกแบบสร้างสรรคใ์ห้เกิดความลงตวั เพื่อให้วยัรุ่นหรือคนรุ่นใหม่ไดเ้กิด
จิตสํานึกในการช่วยเหลือผูพิ้การไม่ว่าจะเป็นทางตรงหรือทางออ้มเช่น   การอาํนวยความสะดวก
ต่างๆในการคมนาคมหรือการอาํนวยความสะดวกในการดาํเนินชีวิต และให้ความช่วยเหลือความใส่
ใจกบัผูพิ้การท่ียงัดอ้ยโอกาสทางสังคม  
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1.2 วตัถุประสงค์ 
 
 1.2.1 ศึกษาการทาํเทคนิคอินฟอร์เมชัน่กราฟิกและแนวศิลปะป็อปอาร์ตเพื่อให้เกิดความ
ลงตวั 
 1.2.2 เพ่ือใหว้ยัรุ่นในยคุปัจจุบนัหนัมาสนใจใหม้ากข้ึนและปลูกฝังจิตสาํนึกให ้ความ 
ช่วยเหลือความใส่ใจกบัผูพิ้การท่ียงัดอ้ยโอกาสทางสงัคม 
 

1.3 ขอบเขตของการวจิัย 
 
 1.3.1 ดา้นเน้ือหา 
  1.3.1.1 ศึกษางานอินฟอร์เมชัน่กราฟิก จากส่ือโฆษณาและรณรงคต่์างๆ และส่ือ 
ออนไลน ์
 1.3.1.2 ศึกษาแนวงานศิลปะป็อปอาร์ต  
 1.3.1.3 ศึกษาปัญหาของผูพิ้การท่ีดอ้ยโอกาส จากงานวิจยัและมูลนิธิอนุเคราะห์คน 
พิการในพระราชูปถมัภข์องสมเดจ็พระศรีนครินทราบรมราชชนนี 
 1.3.2 ดา้นประชากร 
 วยัรุ่นไทย อาย ุ18-25 ปี 
 1.3.3 ดา้นการผลิต 
 1.3.3.1 เขียนบท    1  เร่ือง 
  1.3.3.2 ออกแบบส่ือ   1  ชุด 
 1.3.3.3 สร้างส่ืออินฟอร์เมชัน่กราฟิก 2.30  นาที 
 

1.4 วธีิในการดาํเนินงาน 
 
 1.4.1 การวิจยัขั้นปฐมภูมิ 
 1.4.1.1 ศึกษาหาแหล่งขอ้มูลปัญหาของผูพิ้การท่ีดอ้ยโอกาส 
  1.4.1.2 ศึกษารูปแบบงานศิลปะป็อปอาร์ต 
  1.4.1.3 ศึกษาขั้นตอนการทาํงานอินฟอร์เมชัน่กราฟิก 

 1.4.2 การวิจยัขั้นทุติยภูมิ 
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 1.4.2.1 ลงพ้ืนท่ีเพ่ือศึกษาปัญหาโดยตรง 
 1.4.2.2 สรุปขอ้มูลทั้ งหมดแล้วนาํมาเป็นแนวทางโดยใช้เทคนิคอินฟอร์เมชั่น
กราฟิก 
 

1.5 ประโยชน์ที่คาดว่าจะได้รับ 
 
 1.5.1 ไดพ้ฒันาแนวทางการสร้างสรรคเ์ทคนิคอินฟอร์เมชัน่กราฟิกแนวศิลปะป็อปอาร์ต 
 1.5.2 เพ่ือใหว้ยัรุ่นในยคุปัจจุบนัมีจิตสาํนึกท่ีจะช่วยเหลือผูพิ้การใหม้ากข้ึน 
 

1.6 คาํนิยามศัพท์ 
 
 คนพิการ หมายถึง บุคคลซ่ึงมีขอ้จาํกดัในการปฏิบติักิจกรรมในชีวิตประจาํวนั เน่ืองจากมี
ความบกพร่องทางการเห็น การได้ยิน การเคล่ือนไหว การส่ือสาร จิตใจ อารมณ์ พฤติกรรม 
สติปัญญา การเรียนรู้ หรือความบกพร่องอ่ืนใด ประกอบกบัมีอุปสรรคในดา้นต่างๆ และมีความ
จาํเป็น เป็นพิเศษท่ีจะตอ้งไดรั้บความช่วยเหลือดา้นหน่ึงดา้นใด เพ่ือให้สามารถปฏิบติักิจกรรมใน
ชีวิตประจาํวนัไดอ้ยา่งบุคคลทัว่ไป 
 
 อินฟอร์เมชัน่กราฟิก คือ ภาพหรือกราฟิกซ่ึงบ่งช้ีถึงขอ้มูล ไม่วา่จะเป็นสถิติ ความรู้ ตวัเลข 
ฯลฯ เรียกว่าเป็นการย่นย่อขอ้มูลเพ่ือให้ประมวลผลไดง่้ายเพียงแค่กวาดตามอง ซ่ึงเหมาะสําหรับ
ผูค้นในยคุไอทีท่ีตอ้งการเขา้ถึงขอ้มูลซบัซอ้นมหาศาลในเวลาอนัจาํกดั 
 
 ป็อปอาร์ต คือ แนวศิลปะท่ีเป็นปฏิกิริยาโตต้อบกบัศิลปะลทัธิ แอบ็สแตรค เอก็ซ์เพรสชัน่
นิสม ์ซ่ึงเนน้การแสดงออกทางอารมณ์ความรู้สึก การแสดงความเป็นส่วนตวั มีแนวงานเป็นของ
ตวัเองและเร่ืองของจิตวิญญาณ แต่ พอ็พ อาร์ต กลบัหยบิยมืเอาส่ิงท่ีมีอยูแ่ลว้ในทอ้งตลาด เช่น วสัดุ
สาํเร็จรูป มานาํเสนออยา่งมีชีวิตชีวา งานของ พอ็พ อาร์ต มกัจะมีอารมณ์ขนั ข้ีเล่นและชอบเสียดสี 
เยย้หยนัต่อศิลปะและชีวิต เราจะกล่าวถึง (Roy Lichtenstein) เป็นศิลปินชาวอเมริกนัแนวป็อปอาร์ต
ในแบบป็อป ท่ีง่ายยิง่กว่าใครๆ เขาไดห้ยบิเอาการ์ตูน และภาพโฆษณาท่ีเห็นกนัอยูทุ่กวนัมาทาํเป็น
งานศิลปะ โดยเขาไดใ้ชเ้ทคนิควิธีการ ท่ีนาํภาพเหล่านั้นมาขยายใหใ้หญ่โตข้ึนตามขนาดและ
สดัส่วนท่ีเป็นจริง โดยใชสี้นํ้ามนัหรือสีอะคริลิคลงสีใหเ้ป็นบริเวณแบน เรียบ และมีเส้นวาดท่ี
ชดัเจนหรือไม่กท็าํเป็นจุดๆ แต่ความเป็นมาของเขาเป็นอยา่งไรอ่านในบทถดัไป



 
 

บทที่ 2 
 

เอกสารและงานวจัิยทีเ่กีย่วข้อง 
 

 การศึกษาเร่ืองการออกแบบส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะป็อปอาร์ตเพ่ือผูพิ้การท่ีดอ้ย
โอกาสทางสังคมผูว้ิจยัไดท้างการศึกษาคน้ควา้ แนวคิด ทฤษฎีเอกสารต่าง ๆ และผลงานท่ีเก่ียวขอ้ง
เพ่ือเป็นพ้ืนฐานและแนวทางในการวิจยั โดยมีเน้ือหาสาระสาํคญัดงัน้ี 

 

2.1 แนวคดิทีเ่กีย่วข้องกบัการสร้างส่ืออนิฟอร์เมช่ันกราฟิก 
 
 การออกแบบอินฟอร์เมชั่นกราฟิก เป็นการนําข้อมูลท่ีเข้าใจยากหรือข้อมูลท่ีเป็น
ตวัหนงัสือจาํ นวนมากมานาํเสนอในรูปแบบต่างๆอยา่งสร้างสรรค ์ใหส้ามารถเล่าเร่ืองไดด้ว้ยตวัเอง 
มีองคป์ระกอบท่ีสาํคญัคือ หวัขอ้ท่ีน่าสนใจภาพและเสียงซ่ึงจะตอ้งรวบรวมขอ้มูลต่างๆใหเ้พียงพอ 
แลว้นาํมาสรุป วิเคราะห์ เรียบเรียงแสดงออกมาเป็นภาพจึงจะดึงดูดความสนใจไดดี้ ช่วยลดเวลาใน
การอธิบายเพ่ิมเติม กราฟิกท่ีใชอ้าจเป็นภาพ ลายเส้น สัญลกัษณ์ กราฟ แผนภูมิ ไดอะแกรม ตาราง 
แผนท่ี ฯลฯ จดัทาํให้มีความสวยงามน่าสนใจ เขา้ใจง่าย สามารถจดจาํไดน้านทาํให้การส่ือสารมี
ประสิทธิภาพมากข้ึน  

 

 
รูปท่ี 2.1 ส่ืออินฟอร์เมชัน่กราฟิก 

ท่ีมา: ส่ืออินฟอร์กราฟิก Infoemation Design, 2559 
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รูปท่ี 2.2 ส่ืออินฟอร์เมชัน่กราฟิก 
ท่ีมา: ส่ืออินฟอร์กราฟิก Infographics Design, 2559 

  
 2.1.1 หลกัการออกแบบอนิฟอร์เมช่ันกราฟิก แบ่งเป็น 2 ส่วนคือ 
  
 ดา้นขอ้มูล ขอ้มูลท่ีจะนาํเสนอตอ้งมีความหมาย มีความน่าสนใจเร่ืองราวเปิดเผย
เป็นจริงมีความถูกตอ้ง  
  ดา้นการออกแบบ การออกแบบตอ้งมีรูปแบบ แบบแผนโครงสร้างหน้าท่ีการ
ทาํงานและความสวยงาม โดยออกแบบใหเ้ขา้ใจง่ายใชง้านง่ายและใชไ้ดจ้ริง 

 
 2.1.2 การสร้างอนิฟอร์เมช่ันกราฟิกให้ดงึดูดความสนใจ  
 

 ข้อมูลสารสนเทศสามารถนํามาจัดทาํ ให้สวยงามและมีประโยชน์หากมีการ
นาํเสนอท่ีดี ท่ีผ่านมาขอ้มูลสารสนเทศจาํนวนมากถูกนาํมาจดักลุ่มทาํให้ไม่น่าสนใจ การจดัทาํ
ขอ้มูลใหเ้ป็นภาพกราฟิกจึงเป็นท่ีนิยมในปัจจุบนั อินฟอร์เมชัน่กราฟิกเป็นการออกแบบใหเ้ป็นภาพ
ท่ีช่วยอธิบายขอ้มูลท่ีซบัซอ้นใหเ้ขา้ใจง่าย 
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 2.1.3 การสร้างอนิฟอร์เมช่ันกราฟิกให้มปีระสิทธิภาพ 
 
 อินฟอร์เมชัน่กราฟิกเป็นท่ีนิยมแพร่หลายในอินเทอร์เน็ต เพราะสามารถถ่ายทอด
ขอ้มูลจากการออกแบบ ท่ีมีศิลปะอยา่งแทจ้ริง เป็นภาษาสากลท่ีสามารถเล่าเร่ืองราวแมว้่าดูแค่ภาพท่ี
นาํเสนอ เราสามารถพดูไดว้่าอินฟอร์เมชัน่กราฟิกไม่มีขอบเขตและขีดจาํกดัในการเล่าเร่ืองผา่นภาพ 
การใชก้ราฟิกช่วยเพ่ิมความสวยงามแก่ส่ิงต่างๆทาํใหข้อ้มูลน่าประทบัใจมีคุณค่าอยา่งมีนยัเพ่ือท่ีจะ
เผยแพร่สู่สาธารณะ 
 ประโยชน์และพลงัของ อินฟอร์เมชัน่กราฟิกนั้นมีอยูม่ากมาย เพราะดว้ยแผนภาพ
เหล่าน้ีสามารถทาํให้คนทัว่ๆไปสามารถเขา้ถึงขอ้มูลปริมาณมากๆ ดว้ยแผนภาพ ภาพเดียวเท่านั้น 
ด้วยข้อมูลท่ีถูกคัดกรองมาเป็นอย่างดี ทาํให้ผูอ่้านเข้าใจได้ง่ายเป็นวิธีการนําเสนอข้อมูลเชิง
สร้างสรรค ์ซ่ึงเราสามารถหยิบยกเร่ืองราวเล็กๆ ไปจนถึงเร่ืองราวใหญ่โตมานาํเสนอในมุมมองท่ี
แปลกตา ทนัสมยั ทนัต่อเหตุการณ์ในโลกปัจจุบนั  โดยรูปแบบหรือประเภทของอินฟอร์เมชั่น
กราฟิกตามวตัถุประสงคใ์นการใชง้าน 

 

2.2 ศิลปะป๊อป อาร์ต (Pop Art) 
 
 ศูนยก์ลางความเจริญทางดา้นศิลปวฒันธรรมอยู่ท่ียุโรปยาวนานร่วมๆพนัปีนบัตั้งแต่ยุค
กลางมาแต่พอมาถึงศตวรรษท่ี 20 ฝ่ังอเมริกาก็มีความเคล่ือนไหวท่ีน่าสนใจและวฒันธรรมของ
อเมริกาก็ส่งผลกระทบต่อคนทั้ งโลกอย่างไม่น่าเช่ือด้วยวงการภาพยนตร์ฮอลลีวูดเป็นส่ือนํา
ภาพยนตร์น้ีก่อใหเ้กิดดารา แฟชัน่ การโฆษณา และเพลงประกอบ ซ่ึงลว้นแต่ส่งผลกระทบต่อชีวิต
คนรุ่นใหม่ไปทัว่ทั้งโลก 
 ศิลปะป๊อบอาร์ตท่ีเกิดข้ึนในประเทศสหรัฐอเมริกา ป๊อบอาร์ต เป็นแบบอยา่งของศิลปะท่ี
สะทอ้นพลงัสภาพ แทจ้ริงของสังคมปัจจุบนัตามความรู้สึกความเขา้ใจของสามญัชนทัว่ไป ใน
ชัว่ขณะหน่ึงเวลาหน่ึง  เป็นศิลปะท่ีเก่ียวกบัความชุลมุนวุ่นวายของสงัคม 
 กลุ่มศิลปินท่ีสร้างสรรค์งานชนิดน้ีเ ช่ือว่าศิลปะสร้างข้ึนจากส่ิงสัพเพเหระของ
ชีวิตประจาํวนั เป็นการแสดงความรู้สึกของประสบการณ์ท่ีพบเห็นของศิลปินในช่วงเวลานั้ น
ขณะนั้น ณ.ท่ีแห่งนั้น เร่ืองราวท่ีศิลปินนาํเสนอมีแตกต่างกนัไป เช่น บางคนเขียนเร่ืองเก่ียวกบัดารา
ยอดนิยม เขียนภาพโฆษณา เร่ืองง่ายๆใกล้ๆ ตวัจึงทาํใหห้ลายๆคนเห็นว่างานแนวน้ีไม่ควรค่าแก่คาํ
วา่ศิลปะ เพราะเป็นความนิยมแค่ชัว่วนัชัว่คืน ต่ืนเตน้ ฮือฮา พกัหน่ึงกจ็างหาย 
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รูปท่ี 2.3 Richard Hamilton 
ท่ีมา: Richard Hamilton, 2559 

  
 อยา่งไรกต็ามกลุ่มท่ีนิยมในแนวน้ีกย็งัคงยนืยนัวา่ ป๊อบอาร์ตคือศิลปะ เขาอา้งวา่ ส่ิงเหล่าน้ี
เป็นศิลปะอยา่งแน่นอน เพราะผลงานนั้นกระตุน้ใหเ้ราตอบสนองทางความรู้สึกอยา่งนั้น ท่ีจริงแลว้
ส่ิงท่ีเรารู้ว่าเป็นศิลปะคือ ส่ิงท่ีศิลปินสร้างสรรค์พวกเขามีความเช่ือเก่ียวกับสุนทรียภาพว่า 
สุนทรียภาพคือความรู้สึกท่ีเก่ียวขอ้งกบัสภาพต่างๆท่ีปรากฏในโลกของอุตสาหกรรม โลกชนบท 
และโลกเศรษฐกิจ  
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รูปท่ี 2.4 Andy Warhol : Green Marilyn C .1964 

ท่ีมา: Andy Warhol, 2559 
  
 ศิลปะป๊อปอาร์ต เป็นแบบอยา่งของศิลปะท่ีสร้างความต่ืนเตน้พุง่ข้ึนมาทนัทีทนัใดแก่ผูพ้บ
เห็น อนัมีเร่ืองราวเก่ียวขอ้งกบัคนทัว่ ๆ ไปเป็นเร่ืองราวท่ีแสดงความเป็นอยู่ปัจจุบนั ไม่ใช่เร่ือง
เก่ียวกบั ศาสนา ความเช่ือ หรือ โบราณนิยายอย่างแต่ก่อนๆ ใชเ้ทคนิคตามแบบอย่างศิลปะแอบส
แตรค และเอ็กซเพรสชั่นนิสม์ ศิลปินกลุ่มน้ีล้วนเป็นศิลปินรุ่นหนุ่มล้วนมีความคิดแปลกใหม่
กา้วหน้ามีความเช่ือเก่ียวกบัศิลปะว่า ศิลปะ “สร้างข้ึนมาจากสัพเพเหระของชีวิตปัจจุบนั ในช่วง
ระยะหน่ึง เวลาหน่ึง ซ่ึงสะทอ้นความรู้พ้ืนฐานธรรมดา ท่ีศิลปินมีส่วนร่วมอยูด่ว้ย” ทางดา้นเทคนิค
ใช้เทคนิคทุกอย่างของแอบสแตรค เช่น วิธีหยด สลกั ป้าย เส้นรอบนอกคม ตามท่ีศิลปินตอ้งการ
ทางดา้นเร่ืองราวก็พยายามเน้นรูปวตัถุให้คมชดัเจนแจ่มแจ้งข้ึน และบางทีก็มีความหมายเสียดสี
สงัคมสะทอ้นสงัคมในยคุปัจจุบนัอีกดว้ย 
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2.3 แนวคดิเกีย่วกบัสิทธิของคนพกิาร  

จรัล ดิษฐาอภิชยั (2548, น. 23) ไดก้ล่าววา่ ในทุกสงัคมจะมีคนคนจาํนวนหน่ึงท่ีโชคร้ายเกิด
มาพิการหรือตอ้งพิการจากสาเหตุต่างๆ ซ่ึงจะดาํรงชีวิตอยา่งยากลาํบากโดยเฉพาะเป็นผูด้อ้ยโอกาส
แทบทุกดา้น ไม่สามารถเขา้ถึง มีสิทธิอยา่งคนทัว่ไปดว้ยสภาพทางร่างกายและจิตใจท่ีเป็นอุปสรรค 
ไม่วา่จะเป็นการไปใชสิ้ทธิเลือกตั้ง สิทธิในการทาํงาน การเขา้ถึงการศึกษา รวมทั้งสาธารณสุข ทั้งๆ
ท่ีผูพ้กิารเป็นมนุษยก์ย็อ่มมีสิทธิความเป็นมนุษยเ์หมือนกบัคนปกติ 
 ในประเทศไทยมีผูพิ้การจาํนวนค่อนขา้งมาก ในอดีตผูพิ้การจะไม่ค่อยไดรั้บการดูแลจาก
รัฐและสังคม จนกระทัง่เม่ือมีพระราชบญัญติัการฟ้ืนฟูสมรรถภาพคนพิการในปี พ.ศ. 2534 ผูพิ้การ
จึงค่อยๆไดรั้บการคุม้ครอง การสงเคราะห์ การฟ้ืนฟูสมรรถภาพ แมว้่ากฏหมายและนโยบายมีการ
ส่งเสริมและคุม้ครองสิทธิคนพิการมากข้ึนกว่าในอดีต แต่ในทางปฏิบติัคนพิการก็ยงัเขา้ไม่ถึงสิทธิ
เหมือนคนทัว่ๆไป คนพิการอีกจาํนวนมากท่ียงัไม่ไดรั้บการส่งเสริมและคุม้ครองสิทธิอยา่งเพียงพอ
กระทรวงสาธารณสุขไดส้าํรวจพบว่าประเทศไทยมีคนพิการกว่า 4.8 ลา้นคน แต่มีคนพิการท่ีข้ึน
ทะเบียนกบักรมประชาสงเคราะห์เพียง 1.6 แสนคนเท่านั้น คนท่ียงัไม่ไดข้ึ้นทะเบียนกจ็ะเสียสิทธิอีก
หลายประการ คนพิการควรจะมีสิทธิท่ีจะไดรั้บการศึกษา การมีงานทาํ ไดรั้บการรักษาพยาบาล 
ไดรั้บการช่วยเหลือในสวสัดิการต่างๆ 
 
 2.3.1 ประเภทของคนพกิาร 
 

  จากการให้ความหมายของความพิการขา้งตน้ ทาํให้สามารถแบ่งประเภทของผู ้
พิการไดเ้ป็น 5ประเภท โดยกระทรวงสาธารณะสุข ไดแ้ก่ 

  คนพิการทางการมองเห็น ไดแ้ก่ คนท่ีมีสายตาขา้งท่ีดีกว่าเม่ือใชแ้ว่นสายตาธรรมดา
แลว้มองเห็นนอ้ยกว่า6/18 หรือ20/70ลงไปจนมองไม่เห็นแมแ้ต่แสงสว่างหรือ คนท่ีมีลานสายตา
แคบกว่า 30 องศา 

  คนพิการทางการไดย้นิหรือการส่ือความหมาย ไดแ้ก่ คนท่ีไดย้ินเสียงท่ีความถ่ี 500 
เฮิรตซ์ 1000 เฮิรตซ์หรือ 2000 เฮิรตซ์ในหูขา้งท่ีดีกว่าท่ีมีความดงัเฉล่ียดงัต่อไปน้ี สาํหรับเดก็อายไุม่
เกิน 7 ปี เกิน 40 เดซิเบลข้ึนไปจนไม่ไดย้นิเสียง สาํหรับคนทัว่ไปเกิน 55 เดซิเบลข้ึนไปจนไม่ไดย้นิ
เสียงหรือคนท่ีมีความผิดปกติหรือความบกพร่องในการเขา้ใจหรือการใชภ้าษาพูดจนไม่สามารถส่ือ
ความหมายกบัคนอ่ืนได ้



10 

  คนพิการทางกายหรือการเคล่ือนไหว ได้แก่ คนท่ีมีความผิดปกติหรือความ
บกพร่องของร่างกายท่ีเห็นไดอ้ยา่งชดัเจนและไม่สามารถประกอบกิจวตัรหลกัในชีวิตประจาํวนัได้
หรือ คนท่ีมีการสูญเสียความสามารถในการเคล่ือนไหวมือแขนขาหรือลาํตวัอนัเน่ืองมาจากแขน
หรือขาขาดอมัพาตหรืออ่อนแรงโรคขอ้หรืออาการปวดเร้ือรังรวมทั้งโรคเร้ือรังของระบบการทาํงาน
ของร่างกายอ่ืนๆท่ีทาํให้ไม่สามารถประกอบกิจวตัรหลกัในชีวิตประจาํวนัหรือดาํรงชีวิตในสังคม
เยีย่งคนปกติได ้

  คนพิการทางจิตใจหรือพฤติกรรม ไดแ้ก่ คนท่ีมีความผิดปกติหรือความบกพร่อง
ทางจิตใจหรือสมองในส่วนของการรับรู้อารมณ์ความคิดจนไม่สามารถควบคุมพฤติกรรมท่ีจาํเป็น
ในการดูแลตนเองหรืออยูร่่วมกบัผูอ่ื้น 

  คนพิการทางสติปัญญาหรือการเรียนรู้ ไดแ้ก่ คนท่ีมีความผดิปกติหรือความ
บกพร่องทางสติปัญญาหรือสมองจนไม่สามารถเรียนรู้ดว้ยวิธีการศึกษาปกติได ้
 
 2.3.2 บุคคลที่มคีวามบกพร่องทางการเห็น  
 
  หมายถึง บุคคลท่ีสูญเสียการเห็นตั้งแต่ระดบั เลก็นอ้ยจนถึงตาบอดสนิทอาจแบ่งได ้
 2 ประเภท คือ 
 คนตาบอด หมายถึง คนท่ีสูญเสียการเห็นมากจนตอ้งสอนใหอ่้านอกัษรเบรลลห์รือ
ใช้วิธีการฟังเทปหรือแผ่นเสียงหากตรวจวดัความชดัของสายตาขา้งดีเม่ือแกไ้ขแลว้อยู่ในระดบั 6 
ส่วน 60หรือ 20ส่วน 200 (20/200) ลงมาจนถึงบอดสนิท (หมายถึง คนตาบอดสามารถมองเห็นวตัถุ
ไดใ้นระยะห่างนอ้ยกว่า 6 เมตรหรือ 20 ฟุต ในขณะท่ีคนปกติสามารถมองเห็นวตัถุเดียวกนัไดใ้น
ระยะ 60 เมตรหรือ 200 ฟุต) หรือมีลานสายตาแคบกว่า 20 องศา (หมายถึง สามารถมองเห็นไดก้วา้ง
นอ้ยกวา่ 20 องศา) 
 คนเห็นเลือนลาง หมายถึง คนท่ีสูญเสียการเห็นแต่ยงัสามารถอ่านอกัษรตวัพิมพท่ี์
ขยายใหญ่ไดห้รือตอ้งใชแ้ว่นขยายอ่านหากตรวจวดัความชดัของสายตาขา้งดี เม่ือแกไ้ขแลว้อยู่ใน
ระดบัระหว่าง6 ส่วน 18 (6/18) หรือ20 ส่วน 70 (20/70) ถึง 6 ส่วน 60 (6/60) หรือ 20 ส่วน 200 
(20/200) หรือมีลานสายตาแคบกว่า 30 องศา 
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 2.3.3 บุคคลที่มคีวามบกพร่องทางการได้ยนิ 

  
  หมายถึง คนท่ีสูญเสียการไดย้นิตั้งแต่ระดบัรุนแรงจนถึงระดบันอ้ยอาจแบ่งไดเ้ป็น 
2 ประเภท คือ 
  คนหูหนวก หมายถึง คนท่ีสูญเสียการไดย้ินมากจนไม่สามารถรับขอ้มูลผ่าน
ทางการไดย้นิไม่ว่าจะใส่หรือไม่ใส่เคร่ืองช่วยฟังก็ตามโดยทัว่ไป หากตรวจการไดย้ินจะสูญเสียการ
ไดย้นิประมาณ 90   เดซิเบลข้ึนไป (เดซิเบลเป็นหน่วยวดัความดงัของเสียง หมายถึง เม่ือเปรียบเทียบ
ระดบัเร่ิมไดย้ินเสียงของเด็กปกติเม่ือเสียงดงัไม่เกิน25เดซิเบลคนหูหนวกจะเร่ิมไดย้ินเสียงดัง
มากกว่า 90 เดซิเบล) 
  คนหูตึง หมายถึง คนท่ีมีการไดย้นิเหลืออยูพ่อเพียงท่ีจะรับขอ้มูลผา่นทางการไดย้ิน
โดยทัว่ไปจะใส่เคร่ืองช่วยฟังและหากตรวจการไดย้นิจะพบว่ามีการสูญเสียการไดย้นินอ้ยกว่า 90 เด
ซิเบลลงมาจนถึง26 เดซิเบล คือ เม่ือเปรียบเทียบระดบัเร่ิมไดย้นิเสียงของเดก็ปกติเม่ือเสียงดงัไม่เกิน 
25 เดซิเบล เดก็หูตึงจะเร่ิมไดย้นิเสียงท่ีดงัมากกวา่ 26 เดซิเบลข้ึนไปจนถึง 90 เดซิเบล 
 
 2.3.4 บุคคลที่มคีวามบกพร่องทางสติปัญญา  
 
  หมายถึง  คนท่ีมีพัฒนาการช้ากว่าคนปกติทั่วไปเ ม่ือวัดสติปัญญาโดยใช้
แบบทดสอบมาตรฐานแลว้มีสติปัญญาตํ่ากว่าบุคคลปกติและความสามารถในการปรับเปล่ียน
พฤติกรรมตํ่ากว่าเกณฑป์กติอยา่งนอ้ย 2 ทกัษะหรือมากกว่า เช่น ทกัษะการส่ือความหมายทกัษะทาง
สังคมทักษะการใช้สาธารณะสมบัติการดูแลตนเองการดาํรงชีวิตในบ้านการควบคุมตนเอง
สุขอนามยัและความปลอดภยัการเรียนวิชาการเพ่ือชีวิตประจาํวนัการใชเ้วลาว่างและการทาํงานซ่ึง
ลกัษณะความบกพร่องทางสติปัญญาจะแสดงอาการก่อนอาย ุ18 ปี 

 
 2.3.5 บุคคลที่มคีวามบกพร่องทางร่างกายหรือสุขภาพ  
  หมายถึง คนท่ีมีอวยัวะไม่สมส่วนอวยัวะส่วนใดส่วนหน่ึงหรือหลายส่วนขาด
หายไปกระดูกและกลา้มเน้ือพิการเจบ็ป่วยเร้ือรังรุนแรงมีความพกิารระบบประสาทมีความลาํบาก
ในการเคล่ือนไหว ซ่ึงเป็นอุปสรรคต่อการศึกษาในสภาพปกติทั้งน้ีไม่รวมคนท่ีมีความบกพร่องทาง
ประสาทสัมผสัไดแ้ก่ตาบอดหูหนวกอาจแบ่งไดเ้ป็น 4 ประเภท คือ 
  โรคของระบบประสาท เช่น ซีรีบรัลพลัซี (Cerebral Palsy) หรือโรคอมัพาต
เน่ืองจากสมองพิการโรคลมชกัมลัติเพิลสเคลอโรซีส (Mulitiple Sclerosis) 
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  โรคทางระบบกลา้มเน้ือและกระดูก เช่น ขอ้อกัเสบเท้าปุกโรคกระดูกอ่อนโรค
อมัพาตกลา้มเน้ือลีบหรือมสัคิวลาร์ดิสโทรฟี (Muscular Dystrophy) กระดูกสนัหลงัคด 
  การไม่สมประกอบมาแต่กาํเนิด เช่น โรคศีรษะโตสไปนาเบฟฟิดา (Spina Bifida) 
แขนขาดว้นแต่กาํเนิดเต้ียแคระ 
  สภาพความพิการและความบกพร่องทางสุขภาพอ่ืนๆ ไดแ้ก่ สภาพความพิการอนั
เน่ืองมาจากอุบติัเหตุและโรคติดต่อ เช่น ไฟไหมแ้ขนขาขาด โรคโปลิโอ โรคเยือ่บุสมองอกัเสบจาก
เช้ือไวรัสและอนัตรายจากการคลอดความบกพร่องทางสุขภาพ เช่น หอบหืด โรคหวัใจ วณัโรคปอด 
ปอดอกัเสบ 
 
 2.3.6 บุคคลทีม่ปัีญหาทางการเรียนรู้  
 
  หมายถึง คนท่ีมีความบกพร่องอย่างใดอย่างหน่ึงหรือหลายอย่างในกระบวนการ
พ้ืนฐานทางจิตวิทยาท่ีเก่ียวกบัความเขา้ใจหรือการใชภ้าษาอาจเป็นภาษาพูดหรือภาษาเขียน ซ่ึงจะมี
ผลทาํให้มีปัญหาในการฟัง การพดู การคิด การอ่าน การเขียน การสะกดหรือการคิดคาํนวณรวมทั้ง
สภาพความบกพร่องในการรับรู้สมองไดรั้บบาดเจ็บการปฏิบติังานของสมองสูญเสียไปซ่ึงทาํให้มี
ปัญหาในการอ่านและปัญหาในการเขา้ใจภาษา ทั้งน้ีไม่รวมคนท่ีมีปัญหาทางการเรียน เน่ืองจาก
สภาพบกพร่องทางการเห็นการไดย้ินการเคล่ือนไหวปัญญาอ่อนปัญหาทางอารมณ์หรือความดอ้ย
โอกาสเน่ืองจากส่ิงแวดลอ้มวฒันธรรมหรือเศรษฐกิจ 
 
 2.3.7 บุคคลทีม่คีวามบกพร่องทางการพูดและภาษา 
 
  หมายถึง คนท่ีมีความบกพร่องในเร่ืองของการออกเสียงพดู เช่น เสียงผิดปกติ อตัรา
ความเร็วและจงัหวะการพูดผิดปกติหรือคนท่ีมีความบกพร่องในเร่ืองความเขา้ใจและหรือการใช้
ภาษาพูดการเขียนและหรือระบบสัญลกัษณ์อ่ืนท่ีใชใ้นการติดต่อส่ือสารซ่ึงอาจเก่ียวกบัรูปแบบของ
ภาษาเน้ือหาของภาษาและหนา้ท่ีของภาษา 
 
 2.3.8 บุคคลทีม่ปัีญหาทางพฤตกิรรมหรืออารมณ์  
 

  หมายถึง คนท่ีมีพฤติกรรมเบ่ียงเบนไปจากปกติเป็นอย่างมากและปัญหาทาง
พฤติกรรมนั้นเป็นไปอยา่งต่อเน่ืองไม่เป็นท่ียอมรับทางสังคมหรือวฒันธรรม 
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 2.3.9 บุคคลออทสิตกิ 
 
  หมายถึง บุคคลท่ีมีความบกพร่องทางพฒันาการด้านสังคมภาษาและการส่ือ
ความหมายพฤติกรรมอารมณ์และจินตนาการ ซ่ึงมีสาเหตุเน่ืองมาจากการทาํงานในหนา้ท่ีบางส่วน
ของสมองท่ีผิดปกติไปและความผิดปกติน้ีพบไดก่้อนวยั 30 เดือนและมีลกัษณะท่ีสาํคญัคือมีความ
บกพร่องทางปฏิสัมพนัธ์ทางสังคมการส่ือสารพฤติกรรมและอารมณ์การรับรู้ทางประสาทสัมผสัทั้ง
หา้การใชอ้วยัวะต่างๆ อยา่งประสานสมัพนัธ์การจินตนาการและมีความสนใจท่ีส้ัน เป็นตน้ 
 
 2.3.10 บุคคลพกิารซ้อน 

 
  หมายถึง คนท่ีมีสภาพความบกพร่องหรือความพิการมากว่าหน่ึงประเภทในบุคคล
เดียวกนัเช่นคนปัญญาอ่อนท่ีสูญเสียการไดย้นิ เป็นตน้ 
  ซ่ึงจากความหมายและการแบ่งประเภทของผูพ้ิการขา้งตน้ หากผูพิ้การไดรั้บการ
ลงทะเบียนตามพระราชบญัญติัการฟ้ืนฟูสมรรถภาพคนพิการ พ.ศ.2534 มาตรา 14 แลว้กจ็ะไดรั้บ
การสงเคราะห์ การพฒันา และการฟ้ืนฟสูมรรถภาพ แตกต่างกนัไปตามประเภทของความพิการ 
 

2.4 การแก้ไขปัญหาเพือ่ส่งเสริมและคุ้มครองสิทธิคนพกิาร  
  
  จรัล ดิษฐาอภิชยั (2548, น. 29) ไดก้ล่าวว่า คนพิการนั้นประสบปัญหามากมาย
หลายประการ ทั้ งด้านการศึกษา สาธารณสุข การเข้าถึงสาธารณสถานและยานพาหนะขนส่ง
สาธารณะ ถนนหนทาง ตลอดจนทางเดินเทา้ และท่ีสาํคญัคือเจตคติของสังคม บุคคลท่ีเก่ียวขอ้งมีต่อ
คนพิการในทางลบ การแกไ้ขปัญหาจึงแบ่งออกเป็นหลายๆดา้น 
 
 2.4.1 ด้านกฎหมาย 
 
  โดยรัฐควรปรับปรุงกฏหมาย กฏระเบียบ ขอ้บงัคบัท่ีกีดกนั จาํกดัสิทธิและโอกาส
หรือการเลือกปฏิบติั โดยเฉพาะการละเมิดสิทธิผูพิ้การในดา้นการศึกษา รวมทั้งการเขา้ทาํงานหรือ
การประกอบอาชีพ 
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 2.4.2 ด้านเจตคต ิ 
 

 ควรส่งเสริมและสนบัสนุนในการสร้างเจตคติของสังคม ครอบครัวของคนพิการและคน
พิการเองให้เห็นว่าคนพิการเป็นผูท่ี้มีความสามารถและศกัยภาพเช่นเดียวกบัคนทัว่ไปและสามารถ
พฒันาคนเองได ้
 
 2.4.3 ด้านการศึกษา  

 
 ควรจดับริการการศึกษาท่ีหลากหลายรูปแบบตามความตอ้งการของคนพิการและ
ถา้คนพิการท่ีสามารถเรียนร่วมกบันกัเรียนปกติได ้กค็วรส่งเสริมคนเหล่านั้น โดยคาํนึงถึงการจดัส่ิง
อาํนวยความสะดวกพิเศษ หรืออุปกรณ์พิเศษสาํหรับคนพิการดว้ย นอกจากน้ี ควรขยายบริการดา้น
การศึกษาใหเ้หมาะสม 

 
 2.4.4 ด้านอาชีพ 
   
  ควรส่งเสริมให้คนพิการสามารถพ่ึงตนเองไดแ้ละประกอบอาชีพอิสระได้ อาทิ 
บริการกูย้มืเงินทุนประกอบอาชีพและเคร่ืองมือวสัดุอุปกรณ์ 
  
 2.4.5 ด้านส่ิงอาํนวยความสะดวกอนัเป็นสาธารณะ 

  
 อาทิโทรศพัท ์ทางเดินเทา้ หอ้งนํ้า ตลอดจนบริการขนส่งมวลชน โดยจดัส่ิงอาํนวย
ความสะดวกตามหลกัวิชาใหมี้ลกัษณะทางกายภาพท่ีเอ้ือต่อคนพกิาร 
 
 2.4.6 ด้านกองทุน  

 
 นโยบายพฒันาใหก้องทุนฟ้ืนฟูสมรรถภาพคนพิการสามารถ ใชป้ระโยชน์ไดเ้ตม็
ตามวตัถุประสงคแ์ละสามารถช่วยเหลือคนพิการไดม้ากข้ึน



 
 

บทที่ 3 
 

ระเบียบวธีิการวจัิย 
 
 จากการทบทวนวรรณกรรมท่ีเก่ียวขอ้ง ผูว้ิจยัไดท้าํการศึกษารวบรวมขอ้มูลมาปรับใช ้ใน
การออกแบบส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะป็อปอาร์ตเพ่ือผูพิ้การท่ีดอ้ยโอกาสทางสังคมเพ่ือ
สร้างความเขา้ใจแก่ผูป้กครอง ความยาวประมาณ 3 นาที 1 เร่ือง โดยอาศยัการเคล่ือนไหวของ
ภาพกราฟิก แสง สี เสียง ประกอบการพากย ์โดยมีขั้นตอนและการดาเนินการดงัต่อไปน้ี 
 

 3.1 แนวคดิการเขยีนบทอนิฟอร์เมช่ันกราฟิกแนวศิลปะป็อปอาร์ตเพือ่ผู้พกิารทีด้่อย
โอกาสทางสังคม 
  
 การศึกษาส่ืออินฟอร์เมชัน่กราฟิก จากการรวบรวมและวิเคราะห์ขอ้มูลพบว่า ส่ืออินฟอร์
เมชัน่กราฟิกท่ีจดัทาํข้ึนโดยมีวตัถุประสงคใ์นการถ่ายทอดเร่ืองราวใหผู้ช้มไดรั้บความรู้ หรือเป็น
การใหป้รับเปล่ียนพฤติกรรม เพ่ือใหเ้กิดประโยชน์ สามารถรับชมไดทุ้กเพศทุกวยั เขา้ใจง่าย โดย
เน้ือเร่ืองไดผ้า่นการตดัทอนใหเ้หลือแต่ส่วนสาํคญั อา้งอิงถึงการเก็บรวบรวมขอ้มูลหรือผลกระทบ
จริงท่ีเกิดข้ึน เพ่ือใหเ้น้ือหาดูมีความน่าเช่ือถือ ส่วนในดา้นตวัผลงานมีการวางองคป์ระกอบภาพและ
ฉากใหดู้มีหลายมิติ ทั้งดา้นกวา้ง ดา้นหนา และดา้นลึก จนเกิดเป็นมุมมองท่ีสมบูรณ์ ขบัเคล่ือนดว้ย
ภาพกราฟิกท่ีดูแลว้เขา้ใจไดง่้าย ไม่เป็นรูปทรงท่ีดูซบัซอ้นเกินไป มีการเคล่ือนไหวท่ีหลากหลาย ไม่
สามารถคาดเดาไดถึ้งการเกิดและหายไปของรูปทรง การเช่ือมต่อกนัของรูปทรงอยา่งอิสระท่ีมีสีสัน
สวยงาม นิยมใชสี้ท่ีสดใสเพ่ือใหไ้ม่รู้สึกเบ่ือหน่ายขณะท่ีรับชม เร่ืองและเสียงพากยด์ว้ยถอ้ยคาํท่ี
ชดัเจน กาํหนดนํ้าหนกัเสียงสูงตํ่า เพ่ือเกิดมิติของเสียง ผสานกบัเสียงดนตรีและเสียงเอฟเฟกต ์เสียง
จงัหวะกบัภาพกราฟิกไดอ้ยา่งลงตวัสามารถถ่ายทอดอารมณ์ไดอ้ยา่งมีประสิทธิภาพ ทาํใหน่้าติดตาม
และเกิดความเขา้ใจไดเ้ป็นอยา่งดี  
 ผูว้ิจยัไดท้าํการศึกษาบทความเอกสารหนงัสือท่ีเก่ียวขอ้งกบัศิลปะป๊อปอาร์ตและสิทธิผู ้
พิการ เกบ็รวบรวมขอ้มูลทั้งหมดมาวิเคราะห์แลว้ร่างบทพากยบ์รรยาย โดยเน้ือหาไดก้ล่าวถึงสังคม
ในยุดปัจจุบันทุกอย่างได้ถูกก้าวข้ามขีดจํากัดด้วยเทคโนโลยี ทุกคนในสังคมได้รับความ
สะดวกสบายจนมองขา้มความมีนํ้าใจใหก้บัคนรอบขา้ง แต่กย็งัมีคนอีกกลุ่มท่ีถูกมองขา้มจากสังคม
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นั้นคือผูพิ้การท่ีดอ้ยโอกาส ทุกวนัน้ีผูพิ้การใชชี้วิตอยา่งยากลาํบากถูกเลือกปฏิบติัจากสังคมรวมทั้ง
การเขา้ทาํงานหรือประกอบอาชีพกย็งัถือเป็นเร่ืองยากในการหาเล้ียงชีพตวัเอง ดา้นการศึกษากย็งัถือ
วา่เป็นอุปสรรคของผูพิ้การดว้ยส่ิงอาํนวยความสะดวกอุปกรณ์ทางการศึกษายงัมีไม่ทัว่ถึงกบัจาํนวน
ของผูพิ้การท่ีมีจาํนวนมาก ดา้นส่ิงอาํนวยความสะดวกอนัเป็นสาธารณะอาทิโทรศพัท ์ทางเดินเทา้ 
หอ้งนํ้า ตลอดจนบริการขนส่งมวลชน ยงัไม่เพียงพอต่อความตอ้งการความยากลาํบากในการใชง้าน
หรือท่ีสําหรับคนพิการก็ยงัถูกผูค้นท่ีมีร่างกายปกติเบียดเบียน รถสาธารณะต่างๆก็ยากต่อการ
โดยสารตามป้ายรถประจาํทางไม่มีส่ิงอาํนวยความสะดวกใหก้บัผูพิ้การ การเกิดมามีร่างกายท่ีพิการ
ไม่ปกติกเ็ป็นเร่ืองโหดร้าย ถือเป็นความยากลาํบากในการดาํรงชีวิตประจาํวนัไม่วา่ผูพิ้การจะมีสภาพ
ร่างกายเป็นอย่างไร แต่เขาก็คือมนุษยมี์เกียรต์ิมีศกัด์ิศรีเท่าเทียมกบัคนปกติทุกประการ ดงันั้นใน
ฐานะท่ีเราคนในสังคมส่วนใหญ่มีร่างกายท่ีครบถว้น ก็ควรจะใหโ้อกาสรวมทั้งช่วยเหลือผูพิ้การใน
เร่ืองท่ีเราสามารถทาํไดแ้ละท่ีสาํคญั ไม่ควรแสดงกริยาหรือคาํพดูท่ีไปทาํร้ายจิตใจผูพิ้การ เพราะนั้น
แสดงถึงวา่เราเป็นผูพิ้การทางจิตใจจึงอยากใหทุ้กๆ ท่ีเคยมีทศันะคติไม่ดีกบัคนพิการเปิดใจแลว้มอง
คนเหล่านั้นใหม่ใชจิ้ตใจมองในตวัผูพิ้การนั้นว่าเขาเป็นคนอยา่งไร ไม่ควรตดัสินคนท่ีภายนอก ทุก
คนตอ้งช่วยเหลือกนัไม่ควรซํ้ าเติมความเจ็บปวดท่ีผูพ้ิการพบเจออยูทุ่กวนั อาจเรียกไดว่้าตอ้งเอาใจ
เขามาใส่ใจเรา ถา้ยอ้นกลบัไปถา้เรามีร่างกายท่ีพิการเราจะรู้สึกเช่นไร นํ้าใจเท่านั้นท่ีจะช่วยเยี่ยวยา
รักษาความเจบ็ปวดท่ีผูพิ้การตอ้งเผชิญและจะช่วยใหผู้พิ้การดาํรงชีวิตอยูไ่ดใ้นสงัคม 
 จากบทพากยบ์รรยายประกอบส่ืออินฟอร์เมชัน่กราฟิกน้ี เป็นการช้ีนาํใหค้นในสงัคมให้
เห็นถึงความยากลาํบากในการใชชี้วิตของผูพิ้การท่ีดอ้ยโอกาส จนนาํไปสู่การสร้างจิตสาํนึกใหค้น
ในสงัคมท่ีมีร่างกายผิดปกติช่วยเหลือและอาํนวยความสะดวกใหผู้พิ้การ แบ่งบนันํ้าใจเปล่ียน
ความคิดใหม้องผูพิ้การในทางท่ีดีไม่ใช่วา่ผูพิ้การคือภาระของสงัคม 
 หลงัจากนาํเสนออาจารยท่ี์ปรึกษา ปรับแกจ้นเป็นท่ีน่าพอใจจึงนาสู่กระบวนการทางานใน
ขั้นตอนต่อไป คือการนาํบทพากยท่ี์ไดเ้ขียนไว ้เขา้สู่กระบวนการออกมาเป็นภาพน่ิงโดยการ
เรียงลาํดบัเหตุการณ์ตามเน้ือเร่ืองจนไดบ้ทภาพ จากนั้นจึงนาํบทภาพมาทาํการเคล่ือนไหวประกอบ
เสียงพากยด์ว้ยโปรแกรม Adobe Premiere Pro CS6 เพ่ือใหเ้ห็นภาพรวมของงานทั้งหมด ในการเป็น
ตน้แบบเพ่ือสร้างส่ืออินฟอร์เมชัน่กราฟิก 
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รูปท่ี 3.1 ตน้แบบเพ่ือสร้างส่ืออินฟอร์เมชัน่กราฟิก 
 

3.2 แนวคดิในการออกแบบตัวละครและฉาก 
  
 ใชรู้ปทรงท่ีง่ายไม่ซบัซ้อนสามารถเขา้ใจไดง่้ายจะเนน้สีสันสดใส ดูแลว้สบายตา Warm 
Tone 
ซ่ึงประกอบดว้ย สีเหลือง สีส้ม สีแดง สีม่วง สีม่วงแดง สีเหล่าน้ีใหอิ้ทธิพล ต่อความรู้สึก ต่ืนเตน้ เร้า
ใจกระฉับกระเฉง โดยผูว้ิจยัไดเ้ร่ิมจากการวาดภาพตวัละครและฉากโดยไม่ไดเ้กบ็รายละเอียดมาก
นกั เพ่ือเป็นตน้แบบในการทาํงานเพ่ือใหเ้ห็นถึงภาพรวมของงานทั้งหมด หลงัจากนั้นเร่ิมวางตวั
ละครต่างๆตามท่ีไดก้าํหนดไว ้
 
 
 

 
 
 

  
 

 

 
 รูปท่ี 3.2 การออกแบบตวัละคร 
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3.3 ข้ันตอนการผลติ  
 
 3.3.1 การตกแต่งภาพกราฟิก จากการตรวจสอบบทภาพและบทภาพแบบเคล่ือนไหว โดย
ผา่นอาจารยท่ี์ปรึกษาแลว้ ในส่วนขั้นตอนการผลิตไดเ้ลือกใชโ้ปรแกรม Adobe Illustrator CS6 
สาํหรับสร้างภาพจากภาพวาด และโปรแกรม After Effects CS6 สาํหรับทาํภาพกราฟิกให้
เคล่ือนไหว การตดัต่อภาพและใส่เสียงประกอบดว้ยโปรแกรม Adobe Premiere Pro CS6 ตาม
ขั้นตอนดงัต่อไปน้ี  

 

 

 
รูปท่ี 3.4 โปรแกรมท่ีใชท้าํงาน 

รูปท่ี 3.3 การออกแบบตวัละคร 
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 การสร้างภาพดว้ยโปรแกรม Adobe Photoshop , Adobe Illustrator และโปรแกรม Adobe 
Premiere/ After Effects การตดัต่อภาพจากโปรแกรม Adobe Photoshop แบบพ้ืนหลงัโปร่งใส เปิด
ภาพท่ีตอ้งการใชไ้ปตดัในโปรแกรม  Adobe Photoshop เคร่ืองมือท่ีใชใ้นการตดั ประกอบดว้ย 

 
 

 
รูปท่ี 3.5 รูปตน้แบบ 

 
 เคร่ืองมือหรือ ตวัใดกไ็ดเ้พ่ือเลือก 

 
 
 
 

รูปท่ี 3.6 ขั้นตอนการสร้าง Motion Graphic 
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 ใชเ้คร่ืองมือขา้งตน้เลือกบริเวณตวัการ์ตูนท่ีตอ้งการตดั ดบัเบ้ิลคลิกท่ีเลเยอร์เพ่ือปลดลอ็ก 
 
 
 
 
 

 
 
 

 
 
 กรณีสีวตัถุมีความแตกต่างกบัฉากหลงัชดัเจน ใหใ้ช ้เคร่ืองมือ Magic Wand Tool คลิกไป
บนสีพ้ืนหลงั 1 คร้ัง แลว้กด Delete 

 

 
รูปท่ี 3.8 ขั้นตอนการสร้าง Motion Graphic 

 
 
 
 
  
 

รูปท่ี 3.7 ขั้นตอนการสร้าง Motion Graphic 
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 ตดัภาพตวัใดตวัหน่ึงออกมา โดยใชเ้คร่ืองมือ Selection และใชค้าํสัง่ Edit > Copy 
 

 
รูปท่ี 3.9 ขั้นตอนการสร้าง Motion Graphic 

 
 เปิดหนา้ไฟลข้ึ์นมาใหม่ ใชค้าํสัง่ File > News เลือกพ้ืน หลงัแบบ Transparent (โปร่งใส) 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 3.10 ขั้นตอนการสร้าง Motion Graphic 
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 วางภาพลงบนหนา้ไฟลใ์หม่ โดยใชค้าํสัง่ Edit > Paste บนัทึกภาพ File > Save as เลือก
ประเภทของภาพเป็นไฟล ์PNG เพ่ือใหพ้ื้น หลงัของภาพโปร่งใสเม่ือนาํไปใชใ้นโปรแกรม Adobe 
Premiere 

 
 
 
 
 
 
 
 
 
 
 

 
 นาํไปใชใ้นโปรแกรม After Effects โดยการ Import 
 
 
 
 
 
 
 
 
 

 
 
  
 
 

รูปท่ี 3.11 ขั้นตอนการสร้าง Motion Graphic 

รูปท่ี 3.12 ขั้นตอนการสร้าง Motion Graphic 
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การสร้างภาพจากโปรแกรม Adobe Illustrator เพ่ือนาํมาใชใ้นการตดัต่อ 
 

 วาดภาพในโปรแกรม Adobe Illustrator   
 
 
 
 
 
 
 
 
 

รูปท่ี 3.13 ขั้นตอนการสร้าง Motion Graphic 
 

 เลือกภาพท่ีตอ้งการ แลว้ใชค้าํสัง่ Copy เปิดโปรแกรม Adobe Photoshop โดยใชค้าํสัง่ File 
> New เลือกพื้น หลงัแบบ Transparent 
 

 
 
 
 
 
 
 
  
 
 

รูปท่ี 3.14 ขั้นตอนการสร้าง Motion Graphic 
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 นาํภาพไปวางในไฟล ์ใชค้าํสัง่ Edit > Paste บนัทึกภาพ File > Save as เลือกประเภทของ
ภาพเป็นไฟล ์PNG เพ่ือใหพ้ื้น หลงัของภาพโปร่งใสเม่ือ นาํไปใชใ้นโปรแกรม After Effects 
 

3.4 การสร้างภาพเคลือ่นไหว  
 
 สาํหรับการสร้างภาพเคล่ือนไหวนั้น เร่ิมจากการจดัภาพกราฟิกลงในโปรแกรม After 
Effects CS6 ทาํการจดัเรียงตาํแหน่งภาพกราฟิกแต่ละภาพใหต้รงกบับทภาพ แลว้ปรับใหเ้กิดการทบั
ซอ้นและเวน้ระยะห่างท่ีแตกต่างกนัไป ทั้งดา้นหนา้ ดา้นบน และดา้นขา้งเพ่ือใหดู้ลึกมีมิติท่ีมากข้ึน 
แลว้จึงทาํภาพกราฟิกใหเ้กิดการเคล่ือนไหวตามตน้แบบ  

 

 
รูปท่ี 3.15 การออกแบบภาพเคล่ือนไหว 
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รูปท่ี 3.16 การออกแบบภาพเคล่ือนไหว 

 
 3.4.1 การจดัแสง  
 
 ในการจัดแสงได้เลือกใช้เน้นสีสันสดใส ดูแล้วสบายตา warm tone ซ่ึง
ประกอบดว้ย สีเหลือง สีส้ม สีแดง สีม่วง สีม่วงแดง สีเหล่าน้ีใหอิ้ทธิพล ต่อความรู้สึก ต่ืนเตน้ เร้าใจ 
กระฉบักระเฉง เนน้แสงไปตรงกลางฉากเพ่ือใหต้วังานมีความเด่น 

 

 
รูปท่ี 3.17 การออกแบบการจดัแสง 
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3.5 ข้ันตอนหลงัการผลติ  
 

 3.5.1 Render เป็นขั้นตอนท่ีสามารถตรวจสอบขั้นตอนของการผลิตใหล้ะเอียดเรียบร้อย
อีกคร้ัง หลงัจากนั้นจึง Render รวบรวมขั้นตอนการผลิตทั้งหมดออกมาเป็นภาพ PNG Sequence 
เพ่ือง่ายต่อการตดัต่อและการแกไ้ข โดยใชห้ลกัการสร้างภาพเคล่ือนไหว 25 เฟรม ต่อ 1 วินาที 

 

 
รูปท่ี 3.18 ขั้นตอนการผลิต 

 
รูปท่ี 3.19 ขั้นตอนการผลิต 

 
 3.5.2 Composite นาํภาพ PNG Sequence มาทาํการตดัต่อในโปรแกรม After Effects CS6 
โดยการปรับสีของภาพให้มีความกลมกลืนกนัทั้งหมด และใส่เอฟเฟกต์สั่นภาพลงไปเพ่ือเพิ่ม
อรรถรสในการรับชม 
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รูปท่ี 3.20 ขั้นตอนการผลิต 

 
 3.5.3 การตดัต่อเสียงประกอบ หลงัจากท่ีทาํการ Composition เสร็จไดด้าํเนินการใน
ขั้นตอนสุดทา้ย โดยใชโ้ปรแกรม Adobe Premiere Pro CS6 สาํหรับใส่เสียงพากยบ์รรยายและทาํ
การมิกซ์เสียงดนตรีประกอบเขา้ดว้ยกนั ดว้ยวิธีการตดัต่อปริมาณของเสียงใหมี้ความหนกัเบาและลง
ไปตามจงัหวะการเคล่ือนไหวของภาพกราฟิกใหส้มบูรณ์ท่ีสุด หลงัจากนั้นจึงทาํการ Export ออกมา
เป็นไฟลว์ิดีโอ เป็นอนัเสร็จส้ินในการทาํส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะเดก็ 
 

 
รูปท่ี 3.21 ขั้นตอนการผลิต 



 
 

บทที่ 4 
 

ผลการวจิัย 
 

 การออกแบบส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะป็อปอาร์ตเพื่อผูพิ้การท่ีดอ้ยโอกาสทาง
สังคมเน้ือหาไดช้ี้ให้เห็นถึงประโยชน์และความสาํคญัของศิลปะเด็ก โดยการใชภ้าพกราฟิกแนว
ศิลปะเดก็ มีรายละเอียดผลการออกแบบดงัน้ี  
 

4.1 ผลการออกแบบอนิฟอร์เมช่ันกราฟิกแนวศิลปะป็อปอาร์ตเพือ่ผู้พกิารที่ด้อยโอกาส
ทางสังคม 
 
 ผูว้ิจยัไดล้าํดบัเหตุการณ์ประมวลผลออกมาเป็นภาพ ดงัน้ี  
 สังคมในยุคปัจจุบนัได้ถูกพฒันาไปไกลจนเกือบเทียบเท่าประเทศท่ีพฒันาแล้ว 
ไดผ้ลการออกแบบดงัแสดงใน รูปท่ี 4.1 – 4.2  
 คนในสังคมสะดวกสบายจนมองขา้มความมีนํ้ าใจให้กบัคนรอบขา้ง ดงัแสดงใน 
รูปท่ี4.4  
 แต่กย็งัมีคนอีกกลุ่มท่ีถูกมองขา้มจากสังคมนั้นคือผูพ้ิการท่ีดอ้ยโอกาส ทุกวนัน้ีผูพ้ิการใช้
ชีวิตอย่างยากลาํบากถูกเลือกปฏิบติัจากสังคมรวมทั้งการเขา้ทาํงานหรือประกอบอาชีพก็ยงัถือเป็น
เร่ืองยากในการหาเล้ียงชีพตวัเองไดผ้ลการออกแบบดงัแสดงใน รูปท่ี 4.7-4.8 
 ดา้นการศึกษาก็ยงัถือว่าเป็นอุปสรรคของผูพิ้การดว้ยส่ิงอาํนวยความสะดวกอุปกรณ์ทาง
การศึกษายงัมีไม่ทัว่ถึงกบัจาํนวนของผูพิ้การท่ีมีจาํนวนมาก ไดผ้ลการออกแบบดงัแสดงใน รูปท่ี 4.9 
-4.11  
 ดา้นส่ิงอาํนวยความสะดวกอนัเป็นสาธารณะอาทิโทรศพัท ์ทางเดินเทา้ หอ้งนํ้ า ตลอดจน
บริการขนส่งมวลชน ยงัไม่เพียงพอต่อความตอ้งการความยากลาํบากในการใชง้านหรือท่ีสาํหรับคน
พิการก็ยงัถูกผูค้นท่ีมีร่างกายปกติเบียดเบียน รถสาธารณะต่างๆก็ยากต่อการโดยสารตามป้ายรถ
ประจาํทางไม่มีส่ิงดาํนวยความสะดวกใหก้บัผูพิ้การไดผ้ลการออกแบบดงัแสดงใน รูปท่ี 4.12 - 4.13 
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 การเกิดมามีร่างกายท่ีพิการไม่ปกติก็เป็นเร่ืองโหดร้าย ถือเป็นความยากลาํบากในการ
ดาํรงชีวิตประจาํวนัไม่ว่าผูพิ้การจะมีสภาพร่างกายเป็นอย่างไร แต่เขาก็คือมนุษยมี์เกียรต์ิมีศกัด์ิศรี
เท่าเทียมกบัคนปกติทุกประการไดผ้ลการออกแบบดงัแสดงใน รูปท่ี 4.15 – 4.21 
 ไม่ควรแสดงกริยาหรือคาํพดูท่ีไปทาํร้ายจิตใจผูพิ้การ เพราะนั้นแสดงถึงว่าเราเป็นผูพิ้การ
ทางจิตใจจึงอยากให้ทุกๆท่ีเคยมีทศันะคติไม่ดีกบัคนพิการเปิดใจแลว้มองคนเหล่านั้นใหม่ใชจิ้ตใจ
มองในตวัผูพิ้การนั้นว่าเขาเป็นคนอยา่งไร ไดผ้ลการออกแบบดงัแสดงใน รูปท่ี 4.22 - 4.23  
 ไม่ควรตดัสินคนท่ีภายนอก ทุกคนตอ้งช่วยเหลือกนัไม่ควรซํ้ าเติมความเจ็บปวดท่ีผูพิ้การ
พบเจออยูทุ่กวนั อาจเรียกไดว้่าตอ้งเอาใจเขามาใส่ใจเรา ถา้ยอ้นกลบัไปถา้เรามีร่างกายท่ีพิการเราจะ
รู้สึกเช่นไรไดผ้ลการออกแบบดงัแสดงใน รูปท่ี 4.24 - 4.25  
 นํ้าใจเท่านั้นท่ีจะช่วยเยีย่วยารักษาความเจ็บปวดท่ีผูพิ้การตอ้งเผชิญและจะช่วยใหผู้พิ้การ
ดาํรงชีวิตอยูไ่ดใ้นสงัคมไดผ้ลการออกแบบดงัแสดงในรูปท่ี 4.26 
 

 
  

 

รูปท่ี 4.1 ฉากเปิดหนา้จอคอมพิวเตอร์ 
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รูปท่ี 4.2 อุปกรณ์ต่าง ๆ บงบอกถึงความกา้วหนา้ทางเทคโนโลย ี

รูปท่ี 4.3 สงัคมเมืองท่ีมีตึกสูง 

รูปท่ี 4.4 การใชชี้วิตประจาํวนัของผูค้นในสงัคม 
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รูปท่ี 4.5 ทุกคนในสงัคมไดรั้บความสะดวกสบายจนมองขา้ม
ความมีนํ้าใจใหก้บัคนรอบขา้ง 

รูปท่ี 4.6 ภาพผูค้นค่อย ๆ จางหายไป 

รูปท่ี 4.7 สญัลกัษณ์อุปกรณ์ในการทาํงานค่อย ๆ ชดัออกมา 
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รูปท่ี 4.8 ทุกอยา่งหยดุลง ผูพ้กิารไม่ผา่นการทาํงาน 

รูปท่ี 4.9 อุปกรณ์ทางการศึกษาค่อย ๆ เขา้มาประกอบในฉาก 

รูปท่ี 4.10 อุปสรรคของผูพิ้การดว้ยส่ิงอาํนวยความสะดวกอุปกรณ์
ทางการศึกษายงัมีไม่ทัว่ถึงกบัจาํนวนของผูพิ้การ 
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รูปท่ี 4.11 ฉากหอ้งเรียนค่อย ๆ หายไป 

รูปท่ี 4.12 รถบสัวิ่งเขา้มาในฉาก 

รูปท่ี 4.13 บริการขนส่งมวลชน ยงัไม่เพียงพอต่อความตอ้งการใน
การใชง้าน 
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รูปท่ี 4.14 ฉากป้ายรถเมลค่์อย ๆ ถูกรูปทรงส่ีเหล่ียมปิด 

รูปท่ี 4.15 ท่ีจอดรถของผูพ้ิการถูกแยง่ท่ีจอดโดยคนท่ีมีร่างกาย
ปกติ 

รูปท่ี 4.16 ภาพของผูพิ้การค่อย ๆ ปรากฏข้ึนมา 
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รูปท่ี 4.17 ภาพของผูพิ้การท่ีเสียขาไป 

รูปท่ี 4.18 ภาพชายผูพิ้การอีกคนข้ึนมาแทนท่ี 

รูปท่ี 4.19 ภาพชายพิการท่ีมีอาการหงุดหงิด 
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รูปท่ี 4.20 กลอ้งซูมผูห้ญิงพิการทางสายตา 

รูปท่ี 4.21 กลอ้งค่อย ๆ ซูมออกจากผูห้ญิงพิการทางสายตา 

รูปท่ี 4.22 กลอ้งซูมออกไดเ้ห็นถึงผูค้นในสังคม 
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รูปท่ี 4.25 รูปสัญญาลกัษณ์ผูพ้ิการ 

 

รูปท่ี 4.23 ภาพชายพิการจูงสุนขัค่อย ๆ ชดัข้ึนมา 

รูปท่ี 4.24 ภาพชายพิการจูงสุนขัถูกผูค้นในสงัคมดูถูกว่าร้าย 
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รูปท่ี 4.27 กลอ้งหมุมรอบๆ ผูค้นในสังคม

รูปท่ี 4.26 ผูพิ้การใชชี้วิตร่วมกบัผูค้นในสังคม 



 

 
บทที่ 5 

 

สรุปผลและข้อเสนอแนะ 
 
 จากการวิจยัโครงการออกแบบส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะป็อปอาร์ตเพ่ือผูพ้ิการท่ี
ดอ้ยโอกาสทางสังคม เพ่ือกลุ่มเป้าหมายวยัรุ่นยคุใหม่ไดผ้ลสรุปและขอ้เสนอแนะดงัน้ี  
 

5.1 สรุปผลการวจัิย  
 

 งานวิจยัน้ีไดอ้ธิบายถึงกระบวนการในการศึกษารวบรวมขอ้มูล กระบวนการคิดวิเคราะห์ 
สร้างสรรคอ์อกแบบ และผลิตออกแบบส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะป็อปอาร์ตเพ่ือผูพ้ิการท่ี
ดอ้ยโอกาสทางสังคมท่ีดูสนุกเน้ือหาเขา้ใจง่าย ทาํใหผู้รั้บชมเขา้ใจถึงปัญหาของผูพ้ิการไดม้ากข้ึนมี
ความเอาใจใส่ต่อผูพิ้การใหค้วามช่วยเหลือต่างๆ และยงัสามารถลบลา้งความคิดท่ีมองผูพ้ิการว่าเป็น
ภาระของสังคม ทั้งน้ีผูจ้ดัหวงัว่าการออกแบบส่ืออินฟอร์เมชัน่การฟิกจะสามารถช่วยเหลือผูพิ้การ
ไม่ไดม้ากกน็อ้ย 
 

 5.2 ปัญหาและข้อเสนอแนะ  
 
 5.2.1 ด้านระยะเวลา  การผลิตส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะเดก็มีขอ้จาํกดัเร่ืองเวลา
ในการผลิต เน่ืองจากผูว้ิจยัไดด้าํเนินการขั้นตอนวิธีการต่าง ๆ ดว้ยตวัของผูวิ้จยัเอง ในการเก็บ
รวบรวมและคดัเลือกภาพวาดของเด็กทั้งหมดให้สอดคลอ้งกบัเน้ือหา บทภาพ รวมถึงการทาํ
ภาพกราฟิกจาํนวนมาก ซ่ึงขั้นตอนทั้งหมดน้ีตอ้งใชค้วามละเอียดในการผลิตค่อนขา้งมาก เพ่ือใหไ้ด้
ส่ืออินฟอร์เมชัน่กราฟิกท่ีมีประสิทธิภาพภายในระยะเวลาท่ีกาํหนด 
 5.2.2 ด้านการผลติ การผลิตส่ืออินฟอร์เมชัน่กราฟิกแนวศิลปะเดก็พบว่า เกิดปัญหาใน
ขั้นตอนของการสร้างภาพกราฟิกท่ีมาจากผูพิ้การ เพราะความพิการของแต่ละบุคคลไม่เหมือนกนั 
ภาพกราฟิกให้เกิดการเคล่ือนไหว เน่ืองจากภาพกราฟิกท่ีมีจาํนวนมากประกอบกนัการจดัวางท่ี
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ซบัซอ้น ทาํใหก้ารดาํเนินงานในการกลบัมาแกไ้ขช้ินงานเกิดความยุง่ยาก ซ่ึงบางคร้ังทาใหเ้กิดความ
ผดิพลาดในการทาํใหต้วัช้ินงานเกิดความเสียหายได ้ 
 5.2.3 ด้านเนือ้เร่ือง ในการสร้างเน้ือเร่ืองอินฟอร์เมชัน่กราฟิก ไดท้าํการคน้ควา้จากส่ือ 
แหล่งขอ้มูลต่างๆจากผูพิ้การโดยตรง ผา่นกระบวนทางความคิดของผูว้ิจยัจนเกิดเป็นเน้ือเร่ืองท่ีพึง
พอใจ แต่ดว้ยเน้ือหาท่ีตอ้งคาํนึงถึงบทภาพท่ีแสดงการเคล่ือนไหวใหเ้ป็นไปในแนวทางเดียวกนั การ
พากยเ์สียงท่ีตอ้งกระชบัมีจงัหวะท่ีพอดีและให้ไดใ้จความท่ีสุด จึงจาํเป็นตอ้งตดัทอนเน้ือหา
บางส่วนออกไป ซ่ึงจะส่งผลทาํใหเ้น้ือเร่ืองสาํคญัถูกลดทอนตามลงไปดว้ย 
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